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Welcome to TECOMP 
Easy Planning is one of the markets most user-friendly programs for planning. The program can be used 
for Project-, Maintenance-, Resource Planning and for Booking.  
 
 
Powerful database 
Data is securely stored in an Access Database. The database is updated in real time so all users can see 
the changes. The program has multiuser support and with different permission levels you can control 
what rights users have. 
 
 
Simple and clear planning 
The planning can be viewed as Gantt Chart, resource view or calendar. You can add individual tasks or 
subtasks in a project and then allocate these tasks on the resources you have available. Tasks are always 
displayed in chronological order. If you move a task using drag-and-drop function to a new date is a 
reordering of all tasks directly in the planning. Workload for resources can be displayed graphically. 
 
 
Filter and color coding 
Tasks can be grouped in different categories where each category is assigned a color. Categories are 
used to show filtered lists. With filtered lists can show holiday lists, programs, projects, etc. 
 
 
Sync with Outlook 
Easy Planning can sync with Outlook via Exchange, so you can stay updated on your tasks through your 
phone. The optional software Sync Master running sync automatically in the background.  
 
 
Import and export 
The program has powerful import features to import work orders from external maintenance system. 

 
 

Our hope is that Easy Planning is going to be the tool that simplifies your planning.  
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                          INSTALLATION  
 
 
 
 

System Requirements 
Microsoft Windows 95/98/ME/NT/2000/XP/Vista/Win 7 32/64 bit/Win 8 32/64 bit/Win10 
Windows server 2003, 2008, 2012, 2014, 2016. 
Color monitor with minimum 1024 x 768 screen resolution. 

Installation 
The licenses are per user of the system, not concurrent users. If you have a license for 10 users, 
you have the right to install Easy Planning on 10 computers in your network. 
 
Choose to install the software locally on each user's machine or install the application directly on 
the server. If you choose server installation you must install the customer part of each customer, 
this is done only the first time. 

 
You can always do a reinstallation when upgrading without database and schedules files 
disappear. 

 
 

Alt A, Install program on a server 
 
Install server version (Server.exe) 
The advantage of an installation on the server is that all users are always running the same version 
and that all new updates only needs to be done on the server. You start the software by adding 
a shortcut on the desktop to WINEP6.EXE.  
 
Installation av customer parts (Klient.exe) 
If you have installed the server version you also need to install a customer installation first time on 
each user’s computer. The customer installation will install locally DLL files and ActiveX 
components which the software needs to be able to run. 
 
 

Alt B, Install local version 
 
Install local version (full version) 
The software is installed locally on each user’s computer. Use this installation for Citrix and other 
terminal solutions.  
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Installation – Demo version 
The current demo version of Easy Planning and a user manual is available for download on 
www.tecomp.se. Click on the link to download and save the file SETUP.EXE on the hard drive.  
 
The following applies to the demo version: 
  

- The demo version can be used until the time limit that shows when you start the 
program, after this amount of time you can’t start the program. 

 
- There is a limit of max 100 tasks. In the full version, up to 100.000 tasks/tables can be 

added. 
 

- The demo version is limited to five users. 
 
Install the demo version by double clicking on the file SETUP.EXE. After a few seconds, an 
installation wizard opens that guides you through the installation. 
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Enter path to database 
If multiple users are to work on the same database you would have to assign a path to the data 
files on the server. The data file consists off a schedule and an associated database. 
 
In order to share database and schedule with multiple users you need multiple licenses. A license 
corresponds to one user, not simultaneous users. 

 
If only one person is using the program you do not need to assign a path to the data files, 
instead you can store them in a local subfolder of the Easy Planning folder. 
 

NOTE! As default setting the data files are stored in a subfolder of the program. 
C:\Program Files\Easy Planning\Databas 

 

 

To assign a path to a common database on the server  

1. On the Tools menu, click Maintenance. 
2. Login using password 1234. 
3. Click the Database tab. 
4. In this example we choose F:\TECOMP\EASYPLAN as the path to the data files.  
5. If the folder F:\TECOMP\EASYPLAN Planning exists, click on the button to the right of the 

path. 
 

   
  

 
 



 Installation 

 
 

 12

6. When the form below shows, choose the folder F:\TECOMP\EASYPLAN and click OK. 
 

 
 

7. If the folder doesn’t exist, enter path F:\TECOMP\EASYPLAN. 
 

8. Click OK. 
 

The program creates 4 folders (listed below) when you click OK. 
 
F:\TECOMP\EASYPLAN  for schedules (CFG) 
F:\TECOMP\EASYPLAN\DATABAS  for databases (MDB)  
F:\TECOMP\EASYPLAN\STATUS 
F:\TECOMP\EASYPLAN\TID 

 

 
 

9. Next time you choose menu File - Open schedule the folder will be pointing at 
F:\tecomp\easyplan. 

 
The path is completed and you can start creating your own schedules.  The schedules that you 
build will end up in the folder F:\TECOMP\EASYPLAN and when you open the schedule a 
database will be created in the folder F:\TECOMP\EASYPLAN\DATABAS.  
 
The path to the data files is stored in the file TIDPLAN.INI. 
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Viewer 
Viewers require a separate license. There is no limit to the amount of Viewer users in the system 
(a Viewer can only look at the planning, mark their tasks as completed and enter their own 
timesheet). To specify a user as a Viewer choose permission level 1. Free viewers are included 
when you buy 100 or more planning licenses.  
 

SQL database 
 
The default setting is Access database. New Access databases can be created without installing 
Microsoft Access. This is the easiest way to get going with a limited amout of users.  
 
We always recommend that customers use the SQL version. With an SQL server and database 
the software performance is highly improved compared to Access version. SQL version is free to 
use with Microsoft SQL Server Express.    
 
User profiles are always stored in ’Tidplan.MDB’ 
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GETTING STARTED 
 
 
 

Toolbar 
 

Buttons from left to right 
 

 
 
New Task 
Complete Task 
Delete Task 
Print 
Preview 
Copy 
Paste 
Undo 
Redo 
Outdent Task 
Indent Task 
Add link 
Delete link  
Split task 
Outlook sync 
Search in Database 
View unfinished Tasks 
View not assigned Tasks  
View only assigned Tasks 
View only quotes 
Overview projects 
View Extended time window 

 

 
 
Schedule view 
Gantt Charts 3, 6, 12 weeks 
Gantt Charts 1, 3, 12 months 
Zoom In 
Zoom Out 
Calendar (weekly) 
Annual Calendar (yearly) 
Resource view 5 days 
Resource view 3 weeks 
Resource view 12 weeks 
View Baseline 
View Replanned 
Workload by resources 
Workload in hours or percent 
Workload by number of resources 
View all resources 
Hide all resources 
Backward 1 week/4 weeks 
Go To 
Forward 1 week/4 weeks 
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Go to Today 
View Report menu 

 
Login 

Login is required only to maintenance menu and to schedule builder *). 
 

NOTE! Password is not required in the demo, otherwise default password is 1234 

 
 
To login 

1. Select the schedule view (F2). 
2. On Edit menu, click Schedule Builder. 
3. Or on Tools menu, click Maintenance. 
4. Enter password. 

 
*) It is possible to remove the login too the schedule builder, this is done in the maintenance menu, Tool-
Maintenance. This change affects all users. 
 

Gantt Chart 
 
The Gantt Chart shows one task per row, except for recurring tasks in a serie and split tasks. You can 
press the split bar between task name and the bars to move the partition to the side so that several 
columns can be displayed.  
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The planning that appears for a resource or a group is divided into 4 parts: 
 
1) Tasks   
2) Action list  (Events) 
3) Project  

 
If 'Show headlines for meeting/To do' is selected, they are sorted by group, otherwise put together.  
 
You can view tasks that extend over a long period in a separate action list. Benefit of this list is that it 
only shows end date instead of a lot of long bars. 

 

 
Figure 1. Task are divided into different parts, here with headines  
 
 

 
Figure 2. Without headlines are appointments and to do sorted together 
 
Each project is shown with a project name. You can double click on a project name to show/hide this 
project and all that comes after in the list. Single click on the sign (+/-) to show/hide only the selected 
project. 
 
The duration of a task is displayed in the column duration as the number of working days between the 
start and end dates. In the field planned time, you can specify the estimated time for the task. If the 
planned time is not set manually the planned time follows the duration, which means 100% workload. If 
you enter the planned time manually the bar displayed striped. 

 
Duration can be displayed in either days or hours, enter "d" for day and "h" for hours. Hours can be 
displayed with one decimal place, ex 0.5 h. 
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Resource view 
Resource view shows all tasks on the same line as opposed to Gantt Chart showing one task per line. If 
there are multiple simultaneous tasks, they appear on multiple lines, see picture below. 
 
Can be used for all types of bookings, conference, workshops etc. 
 

 
 
To delete a task in the resource view, right-click on the bar and select ‘Delete Task’ from the context 
menu. To finished a task, right-click and select Completed Task. 
 

 
 
 
View text in row 2 and 3 in bar 
In resource and calendar view, text can also be displayed in line 2 and 3 in bars. For the text to be 
visible you need to increase the row height. You can change the row height in the menu Tools-Options, 
Calendar tab. Default value is 24, increase to 34 for 2 lines and 48 for 3 lines. 

 



  

 
 

 19

  



 Getting Started 

 
 

 20

Weekly Calendar 
The program has a calendar that shows tasks, events and appointments. The calendar can only be 
displayed for one resource at a time, at the group level is button calendar disabled. Use the Zoom bar 
to show a larger timespan.  
 

 
 
 
Appointments are shown in bold in the mini calendar. Not valid for tasks that have been marked ‘all day’. 
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Annual Calendar 
With the annual calendar, you can view all tasks booked a table for a full year, one task per day. If there 
are multiple bookings on the same day they are indicated with an arrow. Annual calendar can be used 
for rough planning where you book the days off. 
 
Annual calendar can only be displayed for one table at a time, at the group level, the button are disabled. 
 

  
 

 
Fig. Multiple bookings one day indicated by an arrow 
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PERMISSIONS 
 
 
 
 

Setting permissions 
The program has five permission levels. In settings you define a permission level for each user. 
 

NOTE! Password is not required in the demo, otherwise default password is 1234. 

 
 
To setting permissions 

1. On the Tools menu, click Maintenance. 
2. Enter password. 
3. Click on the Permission tab. 
4. Select the resource to change. 
5. Current permission appears, choose a new level. 
6. Click the Close button to exit. 
 
 
 
Level 1 – Read-only access (Viewers) 
Set permission to 1 for Viewers. Viewers can only look in the planning, completed tasks and enter their 
own timesheet. 
 
 
Level 2 – Write access to own table 
You can only create tasks in your own table, the same table name as login. 
 
 
Level 3 – Write access to own table and to all link ed tables 
Same as level 2 plus you have write access to all linked tables. 
 
 
Level 4 – All rights 
You have write access to all tables. Many extra functions require permission 4 or higher. 
 
 
Level 5 – Admin permissions 
You have write access to all tables. Admin is required for the following functions: 
 

- To import 
- Edit timesheet 
- Choose type of database Access/SQL 
- Reset entryID 
- To delete a project permanently from the deleted tab 
- To delete a customers register 
- For settings to Sync Master 
- To edit Task Name in gantt chart without form 
- To show all users in the To-Do list 
- To create a copy of the schedule and database 
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Tables with all permission 
Users with permission 2 or 3 get write access in these tables. 
 

Permission by table 
You can limit the number of resources that should have access to a linked table. In the Resources tab, 
you can then choose Only by permission to view only those resources that are authorized to access 
the selected table. 
 

Permission by schedule 
If you have multiple schedules, and want to limit that not all resources can change all schedules you can 
specify which schedules a resource have access to. The resource will then have permission to these 
schedules, but read-only access to other schedules. 
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NAVIGATION 
 
 
 
 

The program always starts with the last open schedule. From this schedule you can navigate to a group 
(top box in each column), a resource (a box) or the entire planning (box overview). 
 
You change the schedule and database by clicking on the tabs at the bottom of the screen or select File 
- Open schedule (CTRL-O). Multiple schedules can also be used against a common database. 
 
Easy Planning contains a large number of different views, Gantt Chart (12), resource view (13) and 
calendar (2). You can quickly switch between the different views with the 14 buttons to the right of the 
toolbar. Note that the menus on the top row are different depending on whether it is overview or the 
planning.  

 

  
 

Shortcuts for navigation: 
 

F2 Schedule 

F3 Planning 

F4 Time Report 

  

F8 3 weeks Gantt Chart 

F9 5 days resource view 

Shift + F9 Calendar 

F11 Zoom in 

F12 Zoom out 

 
The first of the 14 buttons show the schedule. From the schedule you can choose a group, a resource or 
the total planning (overview). The other buttons is enabled when the planning shows and with those you 
can switch period, view and zooming. 
 
In the list at the top left of the planning view you can easily switch to another resource, group or to 
overview. 
 

     
 

You can move the time period forward or backwards one week at the time. The amount of time depends 
on the current view, see tooltips.  
 

 
 

TIP! Use the arrow keys on your keyboard for fast scrolling. 
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GoTo function 
With the function ‘Go to’ you go directly to the specified date. Choose Go to via the toolbar or in the 
menu Edit – Go To. Shortcut F5. 
 

 
 

Multi select rows with CTRL 
In Gantt Chart you can select multiple rows with the CTRL button. CTRL works for following functions: 
 

- Create links  
- Delete Tasks 
- Copy Task 
- Complete Tasks 
- Set Category 
- Bundle 
- Add or remove resources 

 
 

 
 

 
Ex. Select row 1, 3 and 5 and click Add Link. 
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Switching between resource / project by changing table 
You can quickly switch between resource and project view by right-clicking and selecting 'View 
Resource' or 'Show projects' in the popup menu.  
 
Select a task that has an assigned resource and right-click to jump to the resource table. 
 

 
Fig. Switch from one project to the resource table Thomas 
 
 
Select the project line and right-click to switch to the project table. Filtering is done so that only the 
selected project is displayed. 
 

 
Fig. Switch from resource to the project table 
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CREATE SCHEDULES 
 
 
 
 

Before you can start planning, you need to create a schedule. The schedules function is to create tables 
in the database and then from the schedule navigate to a group or a resource.  

 
A schedule contains a number of groups, each with resources. Each box in the schedule creates a table 
in the database (not the group box). 
 
Clicking on a box collected data for this resource. Clicking on a group collected data from all underlying 
resources in this group. The top level (overview) shows the overall planning. 
  

 
Fig. Sample schedule 
 
 
The box in the schedule has the following meaning.  
 
Link tables ”[Table]” with brackets 
Filtrered list ”Table” with bold font. 
 

 

TIP! If you have the program in the folder autostart it will always be running, and you can use the function 
reminder before meetings. 
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Create a new Schedule 
A schedule can contain up to 601 tables (15 groups each of 40 resources plus a team leader). You use 
the schedule to navigate to a group or resource.  

 
Create a new schedule with the schedule builder. The schedule which is open when you exit the program 
automatically opens next time the program starts. 
 

 
Fig. Schedule builder 
 

NOTE! Enter the password 1234 to login to the Schedule Builder. You can change the password after you 
have login. 

 
 

Options in the schedule 

The text in the columns Table and Name can be specified with underscore.  
 
The column Table with underscore (ex. Thomas_Ellingsen) shows the name of the table on two rows in 
the schedule (in the box) but replace underscore with a space when the table is created in the database.  
 
The column Name with underscore (Thomas Ellingsen_070-3965278) gives tool tips in the schedule on 
several rows but only shows the name until the underscore in the planning views. 
 
Login is used to identify witch user who own the table. (Displayed on the bottom of the screen on the 
users computer) 

 
 
Exchange is used to sync calendars to Outlook or mobile calendar.  
 
Category table sums up all tasks in that category.  
 
Linked table is used on all non-resource tables. 
 

          External is used for temporary resources  
 

 
 



  

 
 

 31

Fictional is used on resource tables when you want to allocate a type of resource rather than a specific 
resource.  
 
The column Counter is used to show the number of active tasks in the current table. The counter is 
updated when switching planning/overview and also when automatically updated is activated. 

 
The column Color is used to highlight important boxes in the overview, for example projects or incoming 
jobs. Choose a color by pressing twice in the column color. To remove a color you choose white color 
in the same column. 
  

 
 

The Schedules parts  

The picture below shows a number of groups that have both resources and linked tables. In the 
schedule builder you create a resource by specifying the table name and the name. 

If you select YES in the field Linked you instead create a linked table, marked with square brackets. 
Linked tables allow you to book tasks in a place (WHERE), and regular tables is then resources (WHO). 

The thin gray bar between the boxes called title and used to group underlying boxes. 

 

 
 

A group  A resource  A linked table 

 

You can color any boxes in your schedule if you want to highlight these boxes. There is also a counter 
for each box showing the number of active tasks in this table. 

 

To create a new schedule 

1. Select schedule view (F2). 
2. On the Edit menu, click Schedule Builder. 
3. Login. 
4. Click New in the toolbar. 
5. Enter a title for the schedule and also ev. name of team leader (can be omitted). 
6. Choose number of groups (1-15) and enter group name. 
7. Enter name in the column Table and Name. Table is shown as boxes in the schedule image and 

Name is shown in the planning views. 
8. Enter user name *). 
9. If filtered list is going to be shown you choose a category in the list. Categories must be created 

first. 
10. Choose YES in column Linked to create a linked table. 
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11. Choose YES in column External to mark this as an external resource. For Workload reports. 
12. Choose YES in column machine to mark the resource as a machine. Affect the calculation of man 

hours. 
13. Enter a title to create a title before the name of the resource in the overview. 
14. Choose YES in column Counter to show the number of active tasks in this table. 
15. Click on column Color twice if you want to add a color to this square in the overview. You reset 

the color selection by choosing white color. 
16. After all information have been filled in, choose File – Save as. 
17. Enter name of the schedule, maximum of 15 characters. Program adds the suffix cfg. 
18. Click Close. 

 
*) The column login is used to map a table to a user. Used for functions as reminder, sync calendar with 
Outlook etc. 
 

NOTE! If you skip a box in a group, the resources that follow in this group will not be shown in the 
schedule either. 

 
To remove a schedule you delete the schedule file with explorer. Schedule files are in the catalog you 
specified as the path to the data files and have the extension CFG.  

 

Add a new resource 
 

To add a new resource 

1. Select schedule view (F2). 
2. On the Edit menu, click Schedule Builder. 
3. Login. 
4. Select the first available row in the desired group. Fill in the signature and name and surname. Do 

you want to place this resource higher in the list, you do so in accordance with the description 
'Change resources/groups position'. 

5. You can also sort an entire group in alphabetical order using the A-Z. 
6. Click Close and save the change. 

 

Delete a Resource 
 

To delete a resource from a schedule 

1. Select schedule view (F2). 
2. On the Edit menu, click Schedule Builder. 
3. Login. 
4. You can delete the entire row by clicking to the left of the line (gray matter) and key Delete. 
5. If there is a blank line between two resources when a resource is deleted, highlight the blank line 

and shift this line down past the last resource in the group. 
6. Click Close to save. 
 
If you want to delete all tasks for the resource you deleted in the schedule, you should also delete the 
database table with the table name that you removed. See Chapter Settings, tab tables.  
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Change resources/groups position 
You can change the position of a resource in a schedule, both within the group and move the resource 
to another group.  
 
To change the position of a resource in a schedule 

1. Select schedule view (F2). 
2. On the Edit menu, click Schedule Builder. 
3. Login. 
4. Select the resource you want to move. Click the up arrow key to change places with the resource 

above or down arrows to change places with the resource below. Right arrow moves to the next 
resource group, the resource ends up last in this group. Left arrow moves to the the previous 
group. 

5. Click Close to save. 
 

 
If you want to change the order of groups in the schedule, select the group you want to move and click 
the 'change group' to the right of the Group View. 
 
To change group order in a schedule 

1. Select the group you want to move by clicking on the group tab. 
2. In order to change places with the next group click on the right button (switch group). 
3. In order to change places with the previous group click on the left button. 
4. Click Close to save. 

 

Common shared database 
Typically, you create a schedule, save it with a name and the database will receive the name of the 
schedule. 
 
If you instead want to use a common shared database for multiple schedules, you can select the 
database during 'shared database' in the schedule builder. When you change the schedule by 
selecting another tab you will remain connected to the shared database. 
 
To use a shared database 

1. On the File tab, click on Open and select the schedule you want to share. 
2. On the Edit tab, click on Schedule Builder 
3. Login to Schedule Builder. 
4. Select a database from the list ’Shared database’. 
5. Click on Close to save and exit Schedule Builder. 
6. Create a new schedule or choose File Open if you want to change an existing schedule. 
7. Repeat steps 4-5 for the schedule you want to change, in step 4, select the same database for all 

schedules. 
8. On the status bar you will see which database is open. 

  



 Create schedules 

 
 

 34 

 

Printing Schedule layout 
You can print a picture of your schedule. On the File tab, click-Print schedule layout. Printing can be done to 
printer or PDF. 
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TASKS 
 

 
 
 
Right click in the planning view gives you the most important choice during edit. 
 
Observe that you do not need to mark on which line a task shall be added, the tasks are always sorted 
in time order. Exceptions for marking are in group level where you mark a line under a resource to 
choose this resource. 

 
NOTE! You need permission level 4 or 5 to be able to change in group level.  
 

Add a task 

You add new task by the form New Task.  
 
To add a task 

1. On the Edit menu, click New Task, or right mouse button. 

2. Fill in data for the task and click Save or key Enter, if you want to create more tasks click on  to 
save existing task and open new form to create a new task instantly.  

 

Fig. Form for new task 
 
 

Task name 
Task name, maximum 60 characters. 

 
Start-, finish date 
Start, finish date can be entered manually or by 
choose a date in the calendar (see figure at right). 
 

 
  

Shortcut INSERT 
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Category 
If you want to search in filtered lists, for example on all courses, choose a category for the task according 
to the list you have added earlier. (it is possible to use 2 separate category lists) 
 
Priority 
You can filter by priority, also multiple choices. Default is 5 (1=highest, 9=lowest). For priority 1 there is a 
red arrow and for priority 2 a blue arrow in front of the task name in the Gantt Chart.  

 
Locked 
Mark locked if you don’t want to be able to move the task. A task that has a locked date is marked with 
a squared chart. A locked task can only be changed by the person who locked it, or if you log in with 
Admin-password. Otherwise you can only see the task as read-only in the form Edit task. 

 
Include weekends 
A marking which means that Saturday and Sunday is counted in as working days. For an action to start 
in a Friday and finish on a Saturday you need to mark include weekends.  
 
All day 
Remove the marking All day if you want to add an appointment with time of day. Enter time and mark 
reminder if you wish to get a reminder. The reminder function is activated even if you work with other 
programs, provided that Easy Planning is running. 

 
Action list 
When you add a task which is going on for a longer period you can use the marking Action list. Instead 
of showing a long chart the task only shows an end marker in image and print.  
 

 
Fig. Action list shows tasks with a marker on the end date 
 

TIP! You can make a search in the database after all tasks in action list.  

 
Recurring 
If you want to add a recurring action you mark recurring and choose how often (range) and the last 
date of the series. Ranges can be days/weeks/months or years.  
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Project 
The project tab is used to add information about a new project: 

- New project or select an existing project 
- Project Description 
- Project Manager 

- Budgeted time on project 
- Deadline 
- Color of the project, otherwise black bar 
- Type of project 
- Customer 
- Project participants  

 
Project information is for all the tasks you later add that belong to the same project. You add a new 
subtask by clicking on the tab projects and select a project in the project list. 
 
You can choose to display the list of projects directly on the first tab. 

 
If you select the quote, projects will be displayed with a transparent background, you can later switch to 
orders when quote enters an order. You get in this way a quick overview of all quotes and orders.  
 
 
Optional 
The option extends the functionality of the form New Task. They are enabled in the maintenance menu, 
view tab.  
 
Options are as follows:  
 

- View projects 
- View Customers 
- View Cost 
- View Article parts 
- View Order number 
- View Calendar 
- View Owner 
- View Ordered by 
- View Competence 
- View Prepare Tab 
- View Improvements Tab 
- And checkbox 1-4 

 
Costs 
You can specify a cost for each task. Choose between a fixed cost or variable cost. The variable count 
cost on the number of hours x hourly rate. Hourly rates are a basic value without category selected (can 
be changed) and an hourly rate per category. The cost added up per project and even per table. 
 
Calendar 
Select between day (8 hours), two shifts (16 hours) or 24-hours calendar. Appointments over several 
days counting duration 8 hours if calendar 8h is used. Start at 2 pm and end at 10 am the day after then 
provides 4 hours of calendar 8h. The calendar 24-hours gives the duration of 20 hours. 
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Change a task 
 

To change a task 

1. On the Edit menu, click Edit Task or the right mouse button. 
2. Change the information and click Save. 
 

Delete a task 
 

To delete a task 

1. Select in the column Task the tasks that to be deleted. 
2. Click Delete. 
3. Confirm that you want to delete the selected tasks. 

 

Move a task 
Select a bar in the Gantt Chart with the mouse and hold the mouse to move with drag-and-drop 
operation.  
 
To move a task 

1. Point to a bar, the cursor displays as a two-way arrow. The task can be moved forward or 
backward in time. 

2. At group level with permissions 4 or 5, the cursor displays as a four-way arrow. The task can also 
be moved from one resource to another resource in the vertical direction (not for recurring). 
 

 
 
3. Hold down the left mouse button and move right or left. The new start date is displayed in a 

separate window. 
4. Release the mouse button on the desired date. 
5. Another way to move an event is too choose Edit – Edit Task, or the right mouse button. Enter the 

new date on the form displayed.  
6. You can also move a task to another table by right-clicking and selecting Move Task. Requires 

permission level 4 or 5. 
  

Shortcut DELETE 
 

 
 

Shortcut F7 
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Copy a task 
Create a copy by holding down the CTRL key while moving the bar.  
 

 
 

Change duration on a task 
Change duration on a task by pointing to the beginning (start date) or end (end date) and use drag-
and-drop function. Mouse cursor appears as a left or right arrow.  
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Set time on a task  
You add new tasks through the form New Task. The duration can be specified in several different ways, 
we describe some variations. 
 

 
 
A. All day event 
Enter the task name, start and finish time. The task will be displayed as a bar from start to finish time. 
Duration is always length from start to finish. Planned time can be the same duration (100%) or you state 
the scheduled time, ex 8 hours for a job that should be performed between Mon-Fri. 
 
If the planned time is not the same as duration a dashed bar will appear. 
 
B. Calculated end date 
Applies a task with a planned start time and expected to take x hours. 
Enter task name and start time, finish date deleting. Enter the time in days (d) or the number of hours (h). 
The end time is calculated on the number of hours allocated to the selected calendar (the parameter 
"number of hours per day"). Default is calendar day 8 hours/day. 

 
 
C. Calculated start date 
Applies a task to be completed specified finish date and expected to take x hours. 
Enter the task name and finish date, delete the start date. Specify the time in days (d) or hours (h). 
 
 
D. An appointment 
Applies to meetings and appointments. 
Enter the start date and uncheck "All Day". Choose time for the start and end date. The duration in hours 
is calculated automatically. 
 
E. Time Measurements 
Valid for tests that will take exactly x hours. 
Enter the Start Time and uncheck "All Day". Then select the time of the start and delete end time. Then 
enter the number of hours (h) as the end time is calculated based on the number of hours divided by 24 
hours (number of hours per day must first be set to 24). You can calculate the start time in the same 
manner with an end time, and number of hours. 
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Completed task 
Acknowledge a task by selecting completed or set 100% complete. Acknowledged tasks are time-
stamped with the current date and the name of the person who acknowledged, see the field changed 
by. 
 
Late tasks, when a task passes deadline and is still active, the end date marked with a red ring.  Tasks that 
are not acknowledged (active) and are before the time period shown are marked by the symbol << (in 
Gantt Chart). When the task is acknowledged the bar displays a black line and the first column displays 
a green tick. 
 
To complete a task 

1. Select one or more tasks to be acknowledged. 
2. Click Completed Task. 
3. Confirm. 
 
 
To restore a completed task 

1. Select the task and press key F7 or double click. 
2. Uncheck Finished and click Save.  

 

Recurring tasks 
Recurring events can be set at intervals of days/weeks/months or years. Tasks will be linked to a series 
which means that you can change or delete all the tasks in this series from the selected task and forwards. 
 
A recurring task shows with a circle symbol that the task is recurring. You can move any sub-task in a 
series by double-clicking on a sub-task (bar) or by using drag and drop. 

 

 
 

Reminder 
If you choose reminder, a reminder window "pop up" even if other programs currently in use, provided 
that the Easy Planning is running. You may only reminders of the tasks that belong to you, the table you 
mapped to your user name. 
 
In schedule builder, enter your user name in the field "login" to map your table. 
 
 

 
Fig. Reminder before a meeting 

  

Shortcut END 
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Split a task 
If you need to interrupt work on a task, you can split the task so that part of it starts later in the schedule. 
 

 
 
To split a task 

1. Select a Gantt Chart. 
2. Click on key split task. 
3. On the task's Gantt bar, click the area of the bar on the date where you want the split to occur, 

and left click. 
4. Split is made one day apart. 
5. Drag the second part of the bar to the date that you want work to begin again. 
6. You can split a task multiple times. 

 

 
 

 
 

 
 
You can split a task into how many parts anywhere but a bar must be at least two days long in order to 
be able to split. If you drag a portion of a split task and drop it directly next to another portion, it will be 
merged into the other split task portion. 
 
Each part is a separate task, which means that they can have different task name, category, resources, 
etc. 
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Create Link 
 
In the Gantt chart you can mark two or more tasks to create a link between them. If you move the first one it 
will push the second one forwards or backwards depending on which way you move it. 

 
 

 
 
 
 
You can use delay between tasks in the link.  
 

 
Delay. 
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Undo/redo 

You can undo recent changes by clicking on the cancel button or pressing the keys CTRL + Z.  
Undo can be done for the last 10 changes.  
 
 
 
You can redo the last change you undone by clicking the redo button or pressing the keys CTRL + Y. 
Redo can be done for the last 10 changes. 

 

NOTE !  Undo function is reset when you change to a new resource. 
 

 

Cut - Copy - Paste 
For functions cut - copy regards that up to 10 tasks are stored. This means you can copy up to 10 tasks at 
a time. However, you can cut or remove more than 10 tasks at a time. 
 

 
Cut 
 
Delete the selected tasks. Use Delete when you want to delete a task. The task is placed in the 
clipboard and can be restored with paste. Multiple tasks can be deleted simultaneously. You can also 
delete tasks from the menu Cut. 
 
 
Copy 
 
Create a copy of selected tasks, up to 10 at a time. Use the Copy button to copy a task to multiple people. 
For series regards to copy and paste creates a new series.  
 
 
 
Paste 
 
The tasks stored in the clipboard are pasted into the current table with the Paste button. The task is added 
to the planning of the same text, date, number of hours, etc. as the original. 
 
 
 

Shortcut CTRL + C 

Shoprtcut CTRL + V 

 

 

 

Shortcut CTRL + X, DELETE 
 

Shortcut CTRL + Z 

 
 

 

Shortcut CTRL + Y 
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PROJECT 
 
 
 

 
A project consists of one or several subtasks. 

 
Fig. Example project 

 
 

  
 

   
Fig. Form for new task with separate tab for project 
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To show/hide project details click the plus/minus to the left of the project name in the columns. Double 
click on the project name and you show/hide action for all projects below and including the selected 
project.  

 

 
Fig. Point at the project-line and tooltip is displayed. 
 
In maintenance menu, View tab, you can customize what information is displayed in tooltips. The setting 
apply to all users. 
 

Project time 
You can enter a projects total time in hours under the project tab. For each task added hours will be 
deducted from the project time and the amount of hours left is displayed under the project tab “Time 
left”.  
 

Project status 
Project status is displayed in the project overview with four different colors, one per steps. You can 
rename the steps in the maintenance menu, View tab – Customized texts. 
 

 
 
Black  – Not started 
Green  – In progress 
Yellow  – Interrupted 
Red – Suspended  
Black  – Completed 
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Create a project 
A new project is created via the form ‘new task’ and Project tab. 
 
To create a new project 

1. Click New Task.  
2. Create the first task in the project by entering a task name and time. 
3. Click on Project tab.  
4. Enter a name for the project under New project.  If the name is already being used by another 

project a new project can’t be created. 
5. To add a new subtask to an already existing project select a project from the list below New 

project. 
6. Enter a name for the project. To be able to add a new project the project name should not be 

busy. 
 
Optional  
7. Choose a color for the project by clicking color and then selecting a color. 
8. Enter a description for the project (max 255 letters). 
9. Choose if the project is an order or a quote. If choosing “quote” the project will only be shown 

with black contours. If the project later becomes an order, change quote to order and the project 
will be shown with the correct colors. This enables to easely see the differences between status.  

10. To exit click Save. 
 
NOTE! You can save a project directly under a resource that belongs to a linked table, select a linked table 
under Save in in the Project tab. 

 

Delete a project 
You can delete a project and all tasks related to the project will be removed *). 
 
To delete a project 

1. Right click on the project line or project heading in the column. 
2. Select Delete project in the menu that appears. 
3. You must confirm before the project will be deleted. 

 
*) Deleted project can be restored in the Project Management  
 

Move a project 
Left click and hold on the project and use drag and drop to move the entire project. Completed tasks 
will not be moved. 
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Copy a project 
You can copy a project and all subtasks. Copy to the same table or to another table*).  
 

 
 

*) Enable users to copy/move/delete projects” must be checked in the maintenance menu. 
 

To copy a project 

1. Right click on the project line or the heading in the column. 
2. Select Copy Project in the menu that appears. 
3. Enter a new name for the project. 
4. Choose a table, new start date and if the resources should be copied in the form displayed. 
5. Select OK to create the copy.  

 

Sort project 
Projects are listed in the order that they were made. It is possible to rearrange project as shown below.  
 

 
 
 
To sort a project 

1. Right click on the project line. 
2. Select Sort project in the menu that appears. 
3. A list of all projects is shown. Mark desired project and use the arrows to move the project up or 

down in the list or use one of the displayed options. 
4. Projects will be displayed in chosen order. 
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Rename a project 
You can rename a project but not have the same name on two different projects. 
 
To rename a project 

1. Right click on the project line or the project title. 
2. Select Rename Project from the menu that appears.  
3. Change text on the project and click OK. 

 

Type of project 
You can create a number of ‘type of project’ in the same way as for categories. Then adding a new 
project you can select ‘type of project’ from this list. 
 
You adding ’type of project’ in maintenance menu, tab project. 
 

  
 
Then adding a new task select ’Type of project’ in tab Project. 
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Project filters 
 

 Filters available: 
 
Project leader 
Type of project 
Project 
Project phase 
Project status 
Customer 

 
 

Project Manager 
You can create a list of project manager in the same way as for categories. When the project is created, 
you can select a project manager from this list.  
 
Name of project managers can be displayed as a column in the Gantt Chart and you can filter the project 
at the project manager. 
 

Project Management 
Project Management shows the status of all projects. You can get information about the project, budget, 
hours planned and worked, costs, type of project etc.  
 
If you have deleted a project with all subtasks you can restore the project and all subtasks under the 
Deleted tab. 
 
If you right click on the top list's header you can choose which columns to display. You can also 
reorder the columns and change column width. The changes are saved in your profile in 
TIDPLAN.MDB and persist the next time you select the project management. 
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To display information about a project 

1. On the Tools menu, click Project Management. 
2. Select a project in the list. 
3. The list below displays all subtasks associated with the project. 
4. It is possible to print a report showing time and cost for the project. Click Print.. 
5. If you want to only print one project, right-click in the first column project and select Filter by. Only 

this project will appear in the top list.  
6. The button Export saves data associated to the project on the clipboard and can be pasted in to 

Excel. Copied data is separated with tab. 
7. To reduce the number of projects you can filter on values in multiple columns. Right click and select 

filter by. Reset filtering with button Show All. 
 
 
To filter the project list 

1. On the Tools menu, click Project Management.. 
2. To view all projects with status Green highlight a row of status Green and right-click on the status 

column. Choose Filter by. 
3. You can filter the columns Project Name, Status, Project, Budget, Type of project and Deadline. 
4. Reset a filtered list with button Show all. 

 
 

To change value in a column in project 

1. On the Tools menu, click Project Management. 
2. Select the project you want to change value on. 
3. Right-click eg. status column and select Modify. 
4. You can change value in columns Project Name, Status, Project Manager, Budget, Type of project 

and Deadline. 
 
 
Button Show gantt 
Select a project in the list and click on Show gantt to view this project in a filtered gantt view. 
 
Button Copy 
Select a project and click Copy to create a new copy of the project. 
 
Delete project 
Projects are not deleted from the database, they are only marked as deleted and cannot be found via 
search project . When a project is deleted it ends up under the tab Deleted and can be restored by 
using the Restore button. When restored the project is moved in to Active again.  
 

 

NOTE ! Permission level 4 is needed to delete, complete or restore project. It is still possible to look at, 
copy to clipboard and print project with a lower level of permission.   

 
Projects can be permanently deleted from the tab Deleted by using the Delete button. When a project 
is deleted from the Deleted tab the project can no longer be restored.  Remove empty deletes all 
projects that does not have any tasks associated to it. Both of these actions require permission level 5. 
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Project Templates 
With Project templates it is possible to reuse projects. Create templates via File – Create Project 
Templates. Project templates can be used in any database in Easy Planning.   
 
It is also possible to save existing projects as templates. To create a template on an already existing 
project mark desired project in the Gantt Chart, right click and select “Save project as a template”. 
 

 

 

 

To create a project template 

1. On File menu, click Create Project Templates. 
2. Select New template. 
3. Enter a taskname.  
4. Enter Start as an offset, start with zero. The number used on task number two sets days from start 

zero. If three is entered the task will start three days after the start of the project.  
5. Enter duration in days. 
6. Enter PreID and task link. Under PreID enter the number of the line desired to link task to.   
7. ”Disp” is not used, always one.  
8. Enter a note if desired.  
9. Repeat if more tasks are needed.  
10. When finished select Save As. 
11. Enter a filename.  
12. Close Project Templates. 
 
A much easier way is to right-click on an existing project and save it as a project template. The 
template will also save resources.  
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Add new project from template 
Right click on a blank line and select New project from template in the popup menu. 
 

 
 
Enter the project start date and a new project name. Then choose a project template, project manager, 
type of project and ev a customer. After you click OK opens the form of the project you just created. 

 

Summary Task 
A Summary Task consists of one or more subtasks and can only be created in a project. To create a 
Summary Task select one or more tasks and click the Indent button (right arrow). A summary task is 
created with the first available WBS number at this level. WBS numbering is done individually for each 
project. 

 
Summary Task will be named after the first selected Task  You can easily change the name with right  
click and Summary Task, or by typing the new name directly in the text box that appears in the Task 
name as soon as you press a letter on the keyboard. The last option is only valid for users with 
permission 5. 
 

 
Figure. Right click and select Summary Task or Delete Task. 
 
 

 
Figure. Edit Task name direct in gantt, only for users with permission 5. 
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Ex. The project below shows Summary Task and subtasks.  
 

 
Figure. WBS structure (only for projects) 
 
Summary Tasks numbered automatically in accordance with a WBS structure. You can create up to 9 
levels with 1 - 99 steps per level. 
 
WBS from 1 to 99.99.99.99.99.99.99.99.99 
 
Ex) Below is an example of the WBS structure with indentation of the text. To create 2.1.1, select an task 
at level 2.1 and click Indent Task. To move a task to another Summary Task, simply use drag and drop. 
 
1 
  1.1 
    1.1.1 
2 
  2.1 
3 
  3.1 
  3.2 
    3.2.1 
 
Summary Tasks shows with WBS struktur and subtasks with text only. 
 

  
Figure. Summary Task 
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In form above you can change the name and enter a note. Last changed by and time/date are 
automatically marked when saving. 
 
Show/hide Summary Tasks work the same way as for folders in Windows Explorer, hide WBS 1 to hide 
all its subgroups of Summary Task (1.1, 1.2, 1.2.1, etc.). 
 
Working time and cost are summed per summary task and even at the top level (WBS 1 etc). 
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ASSIGNING RESOURCES 
 
 
 
 

When you add boxes in the schedule you create resources such as people, buildings, cars, or other. To 
assign resources to your tasks, you need something called linked tables. A linked table works like a 
regular table (box in the schedule) with the difference that the Resources tab can be used. You can 
compare a linked table with a location or type of job (place where something should be done) and a 
regular table as a resource (who does the job). 
 
By entering tasks in linked tables, you can assign one or more resources to these tasks. When you assign 
resources to the tasks available in the linked tables, the resources will be able to see these tasks under 
their own planning. 

 
You can see what resources you have available when you make a booking if you select "Show only 
available" when selecting resources. 

 

 
 
Fig. Tasks with resource name assigned  

 
 

The benefits of assigning resources are: 
 

- Tasks can be added in advance in the linked tables. You can then assign resources to these tasks, 
one or more persons to the same task. 
 

- It is easy to replace a resource. 
 

- You only need to edit or acknowledge a task in one place, even if multiple resources are assigned. 

Create a linked table 
In order to allocate resources, you must first create one or more linked tables. 
 
To create a linked table 

1. On the Tools menu, click Maintenance. 
2. Login. 
3. Select Table tab. 
4. In the left list shows all tables created, one for each box in the current schedule. Select desire table 

in the left column to be used as a linked table. 
5. Click the right arrow. The table name will appear in the right column. 
6. Repeat steps 4-5 if you want to create several linked tables. 
7. To exit, click Close. 
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Assign, replace or delete resources 
Allocation of resources can only be made for tasks created in a linked table. For other tables are the 
resource names disabled and resources can’t be selected.  
 
To assign a resource 

1. Enter a new task in a linked table or select Edit Task (F7). 
2. Under the Resource tab, select resources by using drag-and-drop function. 
3. You can also make multiple selections with the keys SHIFT or CTRL. Mark when resources in the left 

list first and then click the right arrow. 
4. To see which resources are available at this time, select "Show only available". 
5. To exit, click Save. 
  

    
 
 

To replace a resource 

1. Select the task you want to change assignment. 
2. Double click on the task, or use Shortcut F7. 
3. Under the resource tab, remove the required resource from the right list. 
4. Then select a new resource. 
5. To exit, click Save. 

 
 

NOTE !  All resources checked = The list on the left shows all resources in the database 
All resources unchecked = Only the resources that appears in the current schedule is shown 
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To delete a resource 

Option 1 
1. To remove a resource, search for this person's planning and select the task you want to unassign.  
2. Double click so that Edit Task displayed. 
3. Under the resources tab uncheck the required resource. 
4. To exit, click Save. 
 
 
Option 2 
1. To remove a resource, search for this person's planning and select the task you want to unassign. 
2. Click Delete. 
3. The assign of this resource is deleted, task remains in the linked table. 

 

NOTE ! When you delete a resource disappears task from this person's planning, but the task is still in 
the linked table. So it is only the assign of resources to remove. To remove the task completely, delete 
the task in the linked table. 

 
 
To select a resource by competence 

1. First select 'View competence' found in the maintenance menu, tab View. 
2. You also need to create a list of competencies and set the levels of each resource. 
3. Enter a new task in a linked table or select change task (F7). 
4. The tab Resources displays all resources or filtered list to a group, only available etc. 
5. Click Competence and select a competence in the list.  
6. Resource list now displays only those resources that meet the requirement. You can also specify a 

level of competence to further filter resources. 
  

  
 

Double-booked warning 
You can get warnings if a resource is double-booked. To enable this feature select menu Tools - 
Maintenance, View tab.  
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FILTERED LISTS 
 
 
 
 

Filtered lists can be shown in: 
 
- List menus, both Gantt Chart and resource view. 
- Fixed category lists, created in the schedule builder and shown in the Gantt Chart.  
 
For all reports you can filter on customers and/or tables when printing. 
 

 

Filtered lists 
There are 7 filters: Category, Type of projects, Project Manager, Project, Customer, Priority and 
Checkboxes. When a filter is active the box to the right of the filters indicate red, and also the list menu 
is shown with an orange background (not shown in Windows 7 with Aero Glass). You can reset all filters 
with the cross to the right of the filter. 
 

 
 
Choose Overview to search in all tables, if you filter on customers only tasks connected to this customer 
is shown. The filter for Project works the same way. 
 
For Category, Type of projects, Priority and Checkboxes you can choose multiple filters. 

Categories 
In the schedule builder you can create boxes which are used for showing fixed filtered lists. For example 
project, vacation, courses or vacation. Categories must be created before they can be used.  
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To use filtered lists you first need to create a category list. When you add a task you choose a category. 
Next step is adding boxes in your schedule, which will be used to show the fixed filtered lists. 
 
When you click a box in the schedule which is marked with category VACATION a search in all tables 
in the schedule will be done after every task with the category “vacation” entered.  
 

 
Fig. Category list 

  
 
Below you can see a holiday list, this you create by selecting overview and resource view 12 weeks and 
filter on category vacation. 
 

 
Fig. Exemple of a vacation list 
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You cannot add new tasks in a fixed filtered list, created from the schedule builder (from the boxes with 
a category assigned). However you can change and delete tasks from a filtered list.  
 
 
Set as default 
In the maintenance menu, Category tab you can choose a category to be used as default. All new tasks 
added then get this category as default. 
 
This function can be useful if you use category to indicate different status steps for example Quote – 
Confirmation – Invoiced – Finished. For new tasks you get the first step selected.  

 
 

Hide tasks for Viewers 
If you have tasks you don’t want Viewers to see you can mark ‘hide for Viewers’ for one or more 
categories. Users with permission level 1 can’t see these tasks.  
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CUSTOMER REGISTER 
 
 
 
 

New customers are added in menu Tools – Customers or the button Add Customer under the Booking 
tab. It is possible to import an existing Customer register.  
 
The Customer register can be used to show a filtered list on a customers booked jobs as well as to print 
customer reports.  

Add a customer 
To add a customer 

1. Click New or key INSERT. 
2. Enter task name and time. 
3. Click on Booking tab. 
4. Click Add customer. 
5. Add data for the new customer and click OK. 
6. You can have multiple contacts for the same customer. Add new contacts with plus and delete a 

contact with minus. 
 

 
 
 

There are four user-defined fields that you can use to make a booking. You can change the texts to fit 
your business under Tools-Maintenance, View tab.  
 
Default headlines are: 
 
- Work Description (Info1) 
- Map Description (Info2) 
- Other (Info3) 
- Booked by (Info4) 
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To make a booking 

1. Click on New or key INSERT. 
2. Enter task name and time. 
3. Click on Booking tab. 
4. Select a customer in the list. 
5. Enter the booking information, four user-defined fields. 
6. Click Save. 
7. The booking can be printed as a report under the Booking tab. 

 

History 
You can view the entire history of a customer by double clicking on the customer in the customer 
register and select the History tab. The list collates and displays all tasks that are performed on the 
selected customer. Costs, planned and worked time. 
 
With the Export button you copy information to the clipboard and can paste into Excel for further 
processing. 
 

 
 
There is also a customer report in the File - Print - Reports that reports all jobs are completed to a 
customer. The report can filter on both the customer and resources so you can print a list of all 
customers a resource has had. 
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Add customer to a project 
You can select the customer to a project instead of a task. All new tasks in the project will receive the 
same customer. Customer to a project are copied to tab Booking and here you can change the 
customer on individual tasks in the project. 
 
Customer to a project is displayed at the project line and are visible even when the project is 
expanded. 
 

  
Fig. Customer by project 
 

Add customer to a task 
Customer can be selected by task or by project above. Under the tab Booking you select a customer 
on individual tasks. You can also choose to display the customer on the first tab, task. This choice is 
made in the Maintenance menu, View tab. Select the option 'Show customers'. 
 

  
Fig. Customer by task 
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TIMESHEET 
 
 
 
 

The program has a build in timesheet. Each user can report the time worked directly on the project and 
tasks in which you join. 
 
3 different options are available for reporting time. 
 

 

 

Auto Completed 
This option calculates the worked h on a task with the help of % finished. The h is only shown 
directly on the task. A timesheet is not generated with this option. 
Worked h I shown directly on the task and in the gantt column ‘Worked h’. 
 

 
 

Manual entry 
Enter worked h directly on the task in the ‘Wrk’ field. No timereport is generated with this option. 
Worked h I shown directly on the task and in the gantt column ‘Worked h’. 
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Timesheet in program 
The form Timesheet is used to report time. This form only shows the existing tasks used in the planning, 
you cannot add new tasks in here. 
 
On the Tools menu, click Timesheet or key F4. The planning view changes to Gantt Chart 1 week and the 
tasks which are booked that week, for the current resource, are shown in the timesheet.  
 

 
Fig. Timesheet 
 
The time is summed per day and week. Worked time is automatically saved per task as well as per 
project.  
 
Click the button Send when you are finished with a week, these locks that week for changes. In the top 
right the last send week is showed. If you need to edit a in a week which has been send you can press 
Reset. Reset can only be done for last sent week making the week you back to the last sent week.  
 
The times you register on a task are stored under worked time. For projects the worked time is summed 
for the subtasks the project contains. 
 
A follow up can then be made per project or per customer where you get the planned time, worked 
time and also cost per task and project. 
 
 

Admin for timesheet 
The administrator can create a list on users who will be admin for the timesheet. An admin can see all 
resources timesheets (only one timesheet at a time) while other users can only see their own timesheet.  
 
Under Tools – Timesheet Manager you get a summary of the latest week sent per user. 
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PRINTING 
 
 
 
 
 

Printing can be done for Gantt Chart, resource view or calendar. If you wish to print every groups 
planning in a list you press the button Overview in the schedule. The calendar can only print one single 
resource. There are also a number of reports you can print. 
 
Ready prints are available for: 

- Gantt Chart from 1 week to half a year 
- Resource view from 1 day to half a year 
- Calendar, week and month 
- Annual calendar 
- Daily schedule and weekly schedule (with signing) 
- Weekly planning 
- Service report 1-2 (under the booking tab) 
- Reports (a number of reports available) 

 
 

Print button 
The buttons Print used the period which is showing on the screen when printing.  
 

 Print button 
 

Preview 
To be able to preview a PDF printer is required. You can choose which PDF printer that should be used 
under the menu Tools – Maintenance, General tab. 
 
We recommend that you install PDF Creator. The advantage of this program is that the program auto- 
save and auto-open automatically. The program is freeware and can be downloaded from our website 
or at http://www.pdfforge.org/pdfcreator. 

 
Settings for PDF Creator: 
 

- Under Auto-Save mark Use Auto-Save. Enter <Title> under filename and <Myfiles> as your 
saving catalogue. 
 

- Under Action mark Action after saving. Choose Adobe reader as reader and start maximized.  
 

 
 

Shortcut CTRL + P 
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Printing Gantt Chart 
If you want to print Gantt Chart for one resource only you choose this resource from the schedule and 
then print.  
 
When you choose a group from the schedule all resources under this group is showed. A print is normally 
done for all resources. If you do not want to print all resources in the group you press the minus to the 
left of the resource you wish to not print. The symbol is changed to a plus and no print is done. 
 
You can also switch between showing/hiding by double clicking on the resource or press the keys +/-. 
If you wish to switch quickly between showing/hiding all resources at once you press the buttons 
show/hide resources or double click on the top resource.  
 
The hidden resources and groups (+) will not be printed in the Gantt Chart. 
 

  
Fig. Group view . The plus hide tasks. 

 

NOTE! Current status to show/hide resources that you controlled with +/- is stored in the database 
TIDPLAN.MDB per user. 

 

Print reports 
All reports are collected in menu File – Reports. For many of the reports, a filtering by customer and/or 
resource can be done. The time period can be weekly report, monthly report or any period of your 
choice, for example 1 year.  
 

 
 

 
 



  

 
 

 73

Workload diagram 
There are two reports summarizing the workload, one per category and one per project type. Summation 
is done per group with one or more groups, or you can select the entire schedules workload in one 
diagram (sum groups). 
 

 
 

Service report / Booking report 
Under Booking tab in form New Task there is a report you can print. This report can be customized to fit 
also for printing bookings. 
 

       
Fig. Service Report Fig. Booking Report 
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Settings 
On the Tools menu, click Maintenance and View tab. Then click on Customized texts and further button 
Booking. 
 

 
 

There are two forms, choose between Form 1 or 2. Form 2 is more suited for builder. 
 
Under settings you can customize the layout and title of the report. You can enter any report name. Info 
1-5 can be found on the Booking tab on form New Task. Type of work 1-6, “Typ av jobb 1-6” are the 
check boxes on the report. Resources and task are titles in the report. The check boxes specify which 
fields are going to be printed. Same for Customer and Logo. 
 
You can specify how many lines you want to show for the field notes and fields info 1-3. You enter the 
minimum and maximum number of lines per field. Minimum 4 and maximum 10 means that at least 4 lines 
is printed and no more than 10 lines (less if the text do not need 10 lines). Minimum is 1 line and maximum 
is 100 lines.  

 
To print the service report or booking report you double click on a task and click on the Booking tab 
and the print button.  

Create custom reports 
You can create your own customized reports in Access 2000. To create a report you need Microsoft 
Access installed and also have exclusive right to the database, which means you are the only one online 
on the database when you create the reports.  
 
When you create a new report in Access you enter source data, can be an existing table or a question 
you have created. You can copy reports and questions from other databases and paste into your own 
database. The list of reports includes reports created in the database TIDPLAN.MDB. 

 
Customized reports can be printed or showed on the screen from Easy Planning. You find them under 
View – Custom Reports. 
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SEARCHING 
 
 

 

Database seaching 
Searches in database tables can be done with up to 25 search conditions. You get to the search window 
by pressing the button Database in the toolbar. 
 

 
Fig. Form for searching databases 

 
Searching is made in all tables in the database. However, you can limit your search to one table by 
choosing table as your search conditions.  
 
The search result can be printed as a report or copied to clipboard. You can sort the result before you 
print if you click on any title in the lower list. 
 
Double-click on a task in the lower list to show the edit task.  
Right-click on a task to highlight this task in the gantt view. 
 
 
Start date, finish date 
- If you enter start date only, searching is done from this date and forward. 
- If you enter finish date only, searching is done for earlier and to this date. 

- If both start and finish date is enter, searching is done between this dates. 
 
Completed date 
Search for tasks completed this date or earlier. 
 

 
 

Shortcut F6 
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Task name 
Free text search. Search for ’text’ in all tasks. Choose between “part of field” (program add % before 
and after) or “whole field”. Multiple choices can be done with a semicolon.  
 
Format:  
[ TEXT1 ; TEXT2 ; TEXT3 ] 
 
Notes 
Search for tasks that contains this text in notes. 
 
Finished 
Search for finished or active task. 
 
Format:  
[ YES  , Y  , 1 ] = completed task 
[ NO , N , 0 ] = active task 
 
Deleted 
Search for deleted task. 
 
Format:  
[ YES  , Y  , 1 ] = deleted task 
[ NO , N , 0 ] = not deleted task 

Action list 
Search for task with action list marked. 
 
Format:  
[YES , Y , 1 ] = action list 
[ NO , N , 0 ] = no action list 

Priority 
Search for tasks with a given priority. Multiple selections can be separated by semicolon. 
 
Format:  
[ priority1 ; priority2 ] 
 
Resources 
Search for tasks with given resource name. Multiple selections can be separated by semicolon. 
 
Format:  
[ resource1 ; resource2 ] 
 
Order ID 
Free text search for order numbers, search in all tasks. 
 
Work Order 
Free text search for work order, search in all tasks. 
 
Table 
Search in a marked table only. If not specified, the search is performed in all tabled in the database. 
 
Project 
Search for tasks with the project chosen from the list. 
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Category 
Search for tasks with the category chosen from the list. 

 
Project manager 
Search for tasks with this project manager. 
 
Project status 
Search for tasks with this status. 
 
Type of project 
Search for projects with selected type. 
 
Customer 
Search for tasks booked on this customer. 

 
Checkbox 1 - 4 
Search for tasks with this field marked. Checkbox 1 – 4 can be replaced with any name in the 
maintenance menu, tab view, customized texts.  
 
Changed by 
Search for tasks last changed by this user name. 
 
Last changed 
Search for tasks changed after this date/time. 
 
Format:  
[Date] or [Date Time]  
 
eg 2013-03-25 12:00 all tasks changed after this date 
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Find tasks 
Search tasks via menu Edit  – Find. A search window appears where you can enter all or parts of a text.  
 
Search is done in the following fields: 
 
- Task name 
- Work order 
- Order ID 
- Project 
- Project No 
 
If you get a hit the task been highlight if the table is in the current schedule.  
 

 
Fig. Find tasks 
 

 

Shortcut CTRL + B 
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IMPORT AND EXPORT 
 
 
 
 

Import tasks 
You can import tasks from external system via text files. The import is done according to the import 
guide below where you choose file, field separator and then mapping columns in the text file to fields 
in the database. You can save a mapping in order to be reused again. 
 

 
 
Functions 
- You can map a field to <Table> and controlling imports to different tables. 
- A text converter translates the column names in the text file to the table name in EP. 
- Is not the table name being mapped is found the task is stored in default table instead. Select 

default table in settings for import. 
- Work order number from the maintenance system is mapped to <Work Order> in EP, gives no 

duplicates. 

- When a work order is history in the external system, these been auto acknowledge/deleted in EP. 
- Import can be made to a category. 
- Timestamps new tasks on import (only for work orders). 

 
  
Overwrite data 
Only the fields that have been mapped will be overwritten when you select 'Overwrite Data'. 
 
Note! The exception is if you made a replanning in EP under the tab prepare, then will not the old start 
and end dates be overwritten during import. 
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Work orders 
You can import working orders from an maintenance system to EP and moving the working orders to 
different tables and then resource planning the tasks. When the working orders are done in the 
maintenance system they can be completed automatically in EP. Auto completed can only be done on 
tasks with a work order number. 
 
In Gantt Chart you can mark a working order, right click and choose ’Copy work order to clipboard’ 
(CTRL+C), the work order will be copied to the clipboard and the number can be paste to you 
maintenance system.  
 
Timestamps of new work orders on imports. This date is then used in the report ‘Statistics work orders’ 
to report the number of new work orders per day Mon-Fri. 
 

Mapping 
The mapping is done as you select a field in the left list and choose to which field in EP data is 
imported. Repeat for all fields you want to import. 
 
The list below shows the fields that have been mapped and the data for the first line of the import file, 
second line if there is a header. You save the mapping in the next step so you do not need to remap 
again the next time you import data. 
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Text Converter 
The text converts function is to remap the table name into the correct table. If you have mapping a 
column to <Table> in Easy Planning, the text converter can “translate” a name in the import file to a 
table name by the converter. 
 
The text convert can also be used in the same way for resource name. 
 

 
Fig. Table name IP/K/AUT from the text file is translated to table Automation 
 
If you import work orders, and have mapping a field to <Table> you can control work orders directly 
to various tables in the database. The control is done in the following order. 
 
- Step 1, same name. Is there a table in the database with the same name as the import file task is 

stored in this table.  
 

- Step 2, use text converter. If there are no table with the same name a check is made against the 
text converter. If you for example set title IP/A/AUT (see Figure above) returned table Automation. 

 
- Step 3, table name is missing. If the table name does not exist in the database or in text converter 

will data be stored in the default table. You select a default table under settings. 
 

The text converter can be found under the Tools Maintenance, View tab. You can add, change and 
delete names from the list. 
 
Are you trying to give a name twice in the left list you get an error message. You can enter several 
different names in the left part that points to the same name (table) in the right part. 
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Integration with other system 
By the Transfer menu, you can easily retrieve data or send data to another system. To view the menu, 
select the settings for import. By specifying a minimum permission, you can limit who is able to use this 
function. 
 

 
 
When you click on the menu option 'Download from <system>' EP will start an import of the import file 
in the folder Import. Are there multiple files, they will be automatically imported one file at a time. 
Before you can use to transfer, you must run the import wizard once to learn the system. 
 
Settings for import are in Tools - Maintenance, Import tab. 
 

  
 
Select an import and an export directory. Default specifies a subdirectory of the data files. 
 
Import to, specifies the default table at which the import should be done if mapping to <Table> are not 
used. 
 
System Name, enter the name of the system integration. Appears in the menu ’Transfer’. 
 
Mapping file, specify the name of the mapping to be used for transfer. 
 
Minimum permission limits the number of users for the transfer function. Viewers can not use 'transfer'. 
 
Select ’View menu transfer’ to view this menu. If you select 'Move import file after import' then the 
import file will be moved to the directory backup after an import. Otherwise the import file will be 
deleted. 
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Import customer register 
You can import your existing customers register to Easy Planning. Press ‘Choose file’ and mark the text 
file that contains your customer register. Select field separator and press Next.  
 
Choose field 1 in the left list and mapping the field against the right list. Repeat for all field in the left list. 
If there is a field you do not want to import you choose ’No field’ in the right list. Finally press Next. 
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Import data from Clipboard 
Data can be imported to Easy Planning using Excel and clipboard. 
 
To import data from Excel 

1. In Excel you create the following columns where you enter (Any text), Task, Time, Start date, End 
date, (Project), (Table) and (Category) in this order. Only one of the columns end date/time needs 
to be completed. Table name should be a table in the database where data is imported. You can 
specify different table names for different rows in Excel. If you omit table name it is imported to the 
marked table. 

 
2. In Excel: Block select from the first row, first column to the last row and last column. Press copy and 

switch to Easy Planning.  
 

3. In Easy Planning: Choose File – Import - Import data from clipboard when you are in the Gantt 
Chart. 

 
4. The following dialog appears. Mark ’Merge column 1-2’ if imported data for task name is divided 

into two columns, for example. Anl.ID and Description. 
 

 
 
5. Click Next. 
 
6. The following list appears. Click Import to apply. 
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Export data 
You can export all new and modified tasks from all tables into a tab-delimited file, 
EXPORT_yyyymmddhhmm.TXT saves in the export directory, see Settings Import.  
 
To export data 

1. On the File menu, click Export. 
2. Select 'Only changed since the last export' or 'All Tasks'. 
3. Alternatively, click on Transfer - Sending data to the system. 

 
Each task has a field Export that will be set to 1 on export. If you change a task or add a new task the 
flag will be set to 0 again. This means that only the changed tasks in EP will be exported. 
 
 
The export file contains the following fields: 
 
 
ID Serial number in the text file 
Workorder Workorder 
Table Table name 
Project Project name 
Task_Name Task name 
Start Start date 
Finish End date 
Duration Duration in hours 
Planned Planned time in hours 
Percent Percent completed 
Resources Resources name separated by semicolon (=20 means 20%) 
Category Category number 
Priority Priority 1-9 
Customer Customer name 
Customer ID Customer ID 
Actual_Work Actual work in hours 
Cost Cost 
Deadline Deadline 
WBS WBS 
Outline_Level Outline level 
Milestone Milestone 1/0 
Last_Changed Last Changed (yyyy-mm-dd hh:mm:ss) 
Notes Notes 
Deleted Deleted 1/0 
Order Order number 
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SYNC WITH OUTLOOK 
 
 
 
 

Easy Planning can sync with Outlooks Calendar, the sync can be started manually or time controlled 
provided that Easy Planning is running. There is also an add-on program Sync Master that can sync 
many calendars automatically. 

 
The result of syncing tasks is showed below. Each project is transferred to Outlook as a category with 
underlying tasks.  
 

 
 

  
 
For tasks the following fields are synced: 
 
Subject Task name 
Categories Project name 
Startdate Start date 
Duedate End date 
Body Notes 
ReminderSet Reminder 
ReminderMinutesBeforeStart Reminder time 
Sensitivity Private 
PercentComplete % completed 
Complete Completed 
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Start synchronize 
Press the button Sync on the toolbar, then the following form will appear. Users who are not Admin 
can only sync their own calendar in Outlook. 

 

 
Fig. Syncing with Outlook. 

 

Settings for Outlook 
Before you can start syncing, Admin needs to do following settings:  
 
- Choose what shall be synced, calendar and/or tasks. 
- Remap table against user name (column Login). 
- If Exchange is used, enter Exchange account for each calendar. 
 
Under Tools – Maintenance, Message tab you choose calendar and/or tasks. You also check 
Exchange Server if Exchange is going to be used.  
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Settings for Exchange 
You can choose to sync with Exchange or with your local PST file (Exchange uses your calendar on the 
server and PST your local calendar file).  
 
If the Exchange server shall be used (normally) you need to enter an Exchange account on the 
Exchange server for each users table. The account can be your E-mail, surname.lastname or any other 
name. Contact your computer support for help. 
 

 
 
You mark one resource (table) at a time and click Change. 
 
- In the column Exchange you enter users E-mail account on the Exchange server. 
- In the column Login you enter user name in the network.  

 

Admin for Exchange 
If you should have Admin rights to sync other users calendars, users must share their calendars to you 
(this is done in Outlook). You can as Admin select any table in the overview diagram and sync this 
calendar for one resource at a time. 
  
You add Admin users in the maintenance menu, tab Admin.  
 

Outlook Category 
Enter any name here and no appointments created in Outlook will be synced, only from Easy Planning 
to Outlook. The category name you enter is marked as a category in outlook and you will see the EP 
tasks in Outlook with for example a yellow color against Outlooks blue color. Note that you can create 
a task in Outlook and select the category name here and then it will be synced.  
 
This category is not used for tasks, means all tasks will be synced. The field category in Outlook is used 
for project names from EP. 

 

EP Categories 
If you have categories you do not want to sync with Outlook you enter these categories here. If there 
are several names they shall be separated with semicolon.  
 
Take for example that you have service that you do not want to sync to Outlook, select the category 
Service then these tasks will not be synchronized. 
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Sync Master 
Program Sync Master can handle the sync automatically. This program is an extension to Easy Planning 
as a separate program that you install on the server. The program is running by Task Scheduler and 
syncs users' calendars via Exchange. 
 

 
 

 
Settings 

Sync Master is integrated with Easy Planning as both settings and results are controlled from Easy 
Planning. The settings for Sync Master is done in menu Tools – Outlook – Setup Sync Master. The 
Settings tab can only be showed for users with permission level 5.  

 

  
 
You select one or more databases that you want to sync. When a database is selected, the list on the 
right will be updated with the tables that are selected to sync from this database.  
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Outlook security 

Because of Microsoft safety barrier that was introduced in Outlook 2002 you need to install Advanced 
Security for Outlook, a freeware program from MAPI Labs. The program is an add-in for Outlook that 
solves the problem below. 
 

 
 
Note! You have to check ’Run Sync Master visible’ and then run Sync Master manual once after every 
update of Sync Master. This is because the program have to approve that Sync Master will get access 
to the Exchange accounts. 
 
The check ’Run Sync Master visible’ must be unchecked if Sync Master is going to run when the server 
is not logged in.  
 
 
Status and error logs 

You see the result of the sync on the tabs Latest, All and Error.  
 
- Latest show the tables that were synced last. Here you can see the time it took to sync each 

calendar, status OK if no errors.  
 

- All show the total time for Sync Master to sync all tables in the list. You see the number of tables 
and any errors that occurred. 

  
- Error list all errors occurred. Here you can see the time when the error occurred, error codes and 

error descriptions. Also the program procedures and table names that were syncing when the 
error occurred. 
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Examples of errors can be that an Exchange account is not distributed, only distributed for reading or 
that the Exchange account is missing.  
 

 
  
For more information about Sync Master, see www.tecomp.se. 
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MISC. FUNCTIONS 
 
 
 

Milestones 
To add a milestone, create a task with duration 0 d and same start/end date. 
 

Deadline 
You can set a date for a task or project to keep track of its finish date. The program updates the 

schedule as needed, keeps track of deadline dates, and shows an in the first column if a task finishes 
after its deadline. Deadline is indicated with a green arrow. 
 

       
Fig. Deadline shown for both a project and a task 
 

 
Fig. Project or task that pass deadline showed with a red symbol 
 
There is a custom report ‘Tasks passed deadline’ under File – Print – Reports.  

Replanned 
A replanning happens when you move a task or change a resource. Date, cause and changed by can 
be stored for up to 5 replannings per task. You activate the function in the maintenance menu, View 
tab, ’Ask before replanning’. 
 
If you move a task or change a resource you need to enter a reason for the replanning. You can 
choose between three different reasons (you can change names on these) or cancel. There is also a 
box ’No registration’ to force if you do not want to store the changes.  
 
You can view the tasks that have been replanned by clicking on Replanned in the toolbar.  
 

 
Fig. Replanned tasks in 3 different colors 

 
- Other cause (grey) 
- Customer (brown) 
- Vendor (blue) 
 

There is a customer report ‘Replanned tasks’ under File – Print – Reports.  
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Create task links 
You can link any two tasks in a project to show their relationship (also called a task dependency). Once 
you link the tasks, every change you make to the previous task affects the next task, which affects the 
next one, and so on. 
 
Note that you can also move a project with drag and drop on the project line. Only the tasks that are 
still active will be moved, not completed.  

 

 
 
A link is showed as a line between two tasks which are connected with an arrow. The arrow indicates 
that this task has one or more previous tasks. Number of days between those tasks remain if you move 
the previous forward or backward (eventual delay will be compressed at first, which means, if it is 2 days 
between two tasks those days will disappear when you move forward). If these days shall remain you 
need to enter a delay (lag time). 

 

 
 

Some tasks may need to be finished before other tasks can start. You can use Finish-to-Start (FS), which 
means that task B will not start until task A is done.  
 
To create a link  

1. Mark the task that is going to have a link (A). Click on the bar or in the column Task name on left.  
2. Press and hold CTRL and mark the next task (B). 
3. Click Add Link. 
4. A link will be created between the two tasks. 
 

 
To delete a link 

1. Mark the task that has a link which shall be removed (the task with an arrow). 
2. Click Delete link. 
3. The link will be deleted. 
 
Or you can remove a link by pressing F7, and under the Previous tab mark the line (link) that you want 
to remove and press DELETE.  
 
You can mark several tasks at the same time with CTRL. Links will be created in the order you mark 
them, for example row 7, 12, 3, 15. 
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Lag time and lead time 
You can enter Lag time as a delay between the previous task and the start of the following task. You 
enter the delay as a positive value, +2d.  
 
Lead time is the overlap between tasks what are linked. If a task is starting when the previous task is 
unfinished you can enter a Finish-to-Start-connection with a lead for the following task. You enter the 
lead as a negative delay, -2d.  

 
To add a delay 

1. Click on the task where you want to add a delay. Double click on the bar or in the column Task 
name. 

2. Press the Previous tab. 
3. Double click on the task you want to change delay.  
4. Increase the time in days to create a delay between the tasks.  
5. Press OK for save.  

 

Public Holiday updates 
You update public holidays from menu Tools – Maintenance, database tab. Click on Holidays and all 
public holidays will be retrieved from www.tecomp.se. Easy Planning is shipped with public holidays 
for Sweden. 
 
You can also manually add you own holidays, do this from Gantt Chart 1 week. Click on desired day 
on the bottom yellow line and it will be marked as a holiday (grey). By clicking one more time you 
remove the mark.  

 
The marks are saved to database TIDPLAN.MDB, and is used for all users in all schedules. Only users 
with level 4 or higher have permission to update holidays.  

 

 
 

Add a logo 
You can add your company logo, maximum size is 195 x 65 pixels and file extension BMP/JPG/GIF. 
You select a logo for each database.  
 
Add a logo 

1. On Tools menu, click Maintenance. 
2. Login. 
3. Click on Footer tab. 
4. Click on Set Footer. 
5. Click Add. 
6. Select logo, must be of file extension BMP/JPG/GIF and max size 195x65 pixels. 
7. The path to the logo is showed in the field Logo. 
8. Click OK to save. 
9. Click Close. 
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Costs 
For each task a cost can be added. When the column cost is showed you see the cost for each task on 
every line, total cost for each project on the projects title line and on the top row the total cost for the 
whole table. If you filter on a customer the cost is showed for that customer.  
 
To show costs 

1. On Tools menu, click Maintenance. 
2. Login. 
3. Click on View tab. 
4. Check ’View Costs’. 
5. Click Close. 
6. On Tools menu, click Options. 
7. Click on General tab. 
8. Check columns displayed Cost. 
9. Click OK. 
 
The cost can be fixed or current. You can count on both costs and income by entering the cost as negative 
values.  
 
For current the cost is calculated as hourly rate x number of hours. Either you have a general hourly rate 
(no category) or you can have different hourly rates for each category. You decide the hourly rate for 
each category when categories are added.  
 

SMS reminder 
With the SMS function you get the possibility to efficiently send texts to employees or customers. An SMS 
is built up as a XML document which is sent to your SMS account.  
 
Note! To use the service (SMS Gateway) you need to get an SMS account at SMS Teknik AB, for more 
information, visit www.smsteknik.se. 
 
To send SMS 

1. On Tools menu, click Maintenance. 
2. Login. 
3. Click Message tab. 
4. Select ’Send message by SMS’. 
5. Click on button SMS. 
6. Enter Sender. 
7. Enter message, this text is used if the SMS is going to be sent to an external customer. You can 

enter <TIME> and <DATE> in the text and these will be replaced with the time and date of the task.  
8. Choose who you want to send the SMS to, either Resource or Customer. 
9. Enter SMS account, here you enter the data you get from SMS Teknik AB if you subscribe to this 

service. 
10. Enter when you want to send the SMS, choose between send immediately or time delayed.  
11. If time delayed SMS you must enter 2 times, if it is the same day you enter how long time before 

start the SMS shall be sent and for SMS that shall be sent one or more days ahead you enter a 
time that day before start time when the SMS shall be sent. 

 
In the form ’New task’ you mark send SMS for each task you want to send an SMS.  
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Options - Prepare 
As an option for form ‘New Task’ you can show the prepare tab. This setting is done in the menu Tools 
– Maintenance, View tab. The prepare tab is used to prepare work that shall be done. The information 
is also used for the report ‘Statistics work orders’ (see Reports).  
 
Normally the bars are blue. Prepare completed gives yellow bars and planned gives green bars.  
 

 

 

Options - Improvements 
As an option for form ‘New Task’ you can show the improvements tab. This tab is used for improvements. 
You set up proposals for change, update the status of improvement and present information in an 
improvement report (see Reports).  
 
Status steps are:  
 
Improvement/Modifications – Reported – Solution are reported to customer – Implemented/Refusals.  
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Actual start date 
When you import working orders from an external maintenance system is often the planned time entered 
as a longer time than the period of time to do the job, for example one whole week Mon-Fri when you 
do not know when during the week the job can be done. The time does not reflect the need. To get a 
better picture of the workload you can enter an actual time under the prepare tab.  

 
 

 
 

If actual date is set, the workload will be calculated on the actual time instead of the planned time. If you 
later import the same work order again and the time is updated in the external system the actual time is 
not changed and you can see that the planned time has been moved. 
 

 
 
Both when actual date have been entered and when the box is planned and the prepare tab have been 
checked, the task will be shown in a green color against the normal blue. This is if no category have 
been chosen, otherwise bars are shown in the color of the category. The color for planned (green) can 
be changed under Tools – Options, colors tab. 
 
Plan stopped is shown in back and Ready not completed is shown in orange. 

 

Expended time window 
Extended time windows means that all booked tasks forward are shown independently of time period 
shown. These are listed with its task name in the left list but without the bars since they are outside the 
shown time period.  
 
Press the button ’Extended time window’ to show all tasks ahead. This is set per user.  
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View resource workloads 
You can see the number of planned and available hours per day/week/month. The workload for each 
resource is calculated by adding number of hours/day for each task in the period. You get number of 
hours/day by dividing the planned time for the task with duration (number of work days). On this way 
all tasks that falls into the chose period are summed up.  
 
No workload is calculated to linked tables and filtered lists.  
 
There is also a report for workload in group level. The workload is calculated for 1 month, 3 months and 
12 months.  

 
 
To view workload 

1. Click on button ’Workload by resources’ (all resources switched to expanded/unexpanded). 
2. Or on Tools menu, click Options. 
3. Check ’Workload by resources’. 
4. Click OK. 
 
In the figure below the task in line 2 has a duration of 3 days and planned time 24 hours which gives a 
workload of 8 hours/day. Monday – Wednesday are fully filled boxes with green.  
 
The task in line 1 has a duration of one week and here the planned time is 20 hours. Time is divide by 
the duration which gives 4 hours/day. Green boxes filled to half for Monday – Friday.  
 

 
Fig. Workload is shown graphically. 

 
By entering planned time in number of hours you can add a task in your planning and then change 
duration so that you will not get overbooked. When you pull in the end date of the task the duration 
rises and when you let go it is calculated again and a new is summed up. 
 
The workload appears on the same line as the resource. If you double click on a resource in the planning 
view you switch to show single tasks or the workload. Click on minus/plus sign to switch function for one 
resource at a time.  

 
Gantt, week 1 - 6  show the workload per day 
Gantt, week 12 - 36  show the workload per week 
Gantt, month, quarterly and half-year  show the workload per month 
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Overbooked days are showed with a yellow color at 9 hours and with a red color at 10 hours or more.  
 

 
 
Workload/day: 
1 - 8 hours   Green color 
9 hours   Yellow color 
10 hours or more   Red color 
 
Workload/week and month * 
1 - 40 hours   Green color 
41 - 48 hours  Yellow color 
49 hours or more   Red color 
 
*) For month according to formula: (SumMonth / duration) x 5 = hours per week 

 

Vacation 
When you as a project manager add projects in linked tables you normally do not see if any resource 
is missing because of vacation. If the resource add a vacation in his table this vacation will be showed in 
the projects.  
 

 

 

 
 
In projects you can see vacations with a thinner black line. If you move the mouse to the bar the tool tips 
will show which resource is absent in this project. Under the resource the vacation is showed with a blue 
symbol at workload.  

 

 
 
Vacation is used for two functions: 
 

- To show vacation in projects. 
- To calculate workload, time available (not used for fixed workload) 
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To get workload right, you have to enter vacation. You mark vacation in the form ‘New task’. Vacations 
are shown with blue markings. 
 

 
 

Automatic logout 
There is a function for automatic logout of all users. You can use it for maintenance (for example when 
updating Easy Planning or compressing the database). 
 
If you activate the automatic logout all users will be logged out and you can login earliest after 3 minutes.   
 
On menu Tools, click Maintenance, Database tab. Check ’Logout all users’. Within one minute you and 
all other users will be logged out from the program.  

 

Move a table to another database 
If a resource need to be moved from one tab to another and the tabs consists of different databases you 
need to move the resources table to another database.  
 
On menu Tools, click Maintenance, Tables tab. Select the table you want to move in the list and click on 
‘Change DB’. The table will be moved to the database you choose in the list. 
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Merge two tables  
If you need to merge data from two tables you can do this in the maintenance menu, Tables tab. Select 
the table in the list you want to move and click on ‘Merge Tables’.  
 
In the form you choose which table you want to move the data. Data will be moved to the chosen table 
and the marked table will be removed.  
 

 
 

 

Show start time in front of bar 
For appointments you can show start time in front of bars in the Gantt Chart. You activate the function in 
the menu Options, tab Calendar, check ’Show time’. It is the same function that show times on bars in the 
calendar view.  

 

 
  



  

 
 

 103

Preliminary book task 
You can preliminary book a task in the same way that a project can be preliminary booked. Preliminary 
booked task appears as a transparent bar, with only the frame. You will find the function under the Task 
tab. 
 
The project quote mode is superior to the task, this means that if the project is in state order the tasks will 
be showing as preliminary booked but if the project is in state quote all tasks will also be displayed as 
quote. 
 
Preliminary booked tasks and projects are not included then work load is calculated. 
 

  

 

Competency and Certificate 
You can create a list of competencies and a list of certificates. These lists can then be used to put the skills 
levels 1-5 for each user's skills. Create Competencies in the maintenance menu, View tab. Click on 
'Competence'. 
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You create a list of competencies under the tabs Competence and Certifications. Then you select a 
resource in the list on the first tab, and then select the competencies and skill levels this resource to have. 
Finally, click Save and continue with the next resource. 

 
You can print a skills list for all resources with the Print button. 
 

 

 

 
When competencies are registered, you can use them to filter resources when new tasks will be added. 
Select 'View competence' in the Maintenance menu, tab to view. Note that competences can only be 
selected for tasks added to linked tables. 
 

 

 

In the figure above, select the competence XenApp 6.5 and the list of resources will search for resources 
that have these skills, resulting in two resources. You can also choose a higher level to further filter out 
resources. 
 
Competence filter can be combined with other filters such as 'Only available', a select group etc. 
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To-Do list 
There is a To-Do list where you can enter incoming job. The list is under button 'To Do'. 
 
Enter a task name and due date (optional). The list is individual and just shows your tasks that you have 
created. 
 
With permission 5 you can select all users and get a total list. This displays an additional column with the 
name of the user who created the task. 
 

 
 
The list is sorted on the column Created allowing the oldest always shown at the top. You can sort on 
any column. 
 
The list can be used as a buffer for incoming jobs. When you want to create a task just double-click in 
the list and get up form for a new task with task name omitted. When saving disappears task from the list. 
 
NOTE To create tasks from the list, you must select the correct table before taking up the list because the 
save is made to the selected table. 
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MAINTENANCE 
 
 
 
 

Easy Planning needs normally a minimum of maintenance. If you get problems with long response times 
the reason may be a table have been damaged, run the database compression that is described below.  
 

Deleting tables  
When you delete a name in the schedule the database table is still there. To remove the table from the 
database, select the menu Tools - Maintenance, Tables tab. 
 

Rename a table  
When you change a table name in a schedule that contains tasks and save the schedule the table name 
will be renamed automatically. You can also rename table names manually, choose menu Tools – 
Maintenance, Tables tab.  
 

Compress Database 
You can reduce the size of the database by making a compression, since the data will be packed together 
without these gaps after deleted tasks. 
  
Another reason to compress the database is to repair the database. This shall be done if an error occurs 
that invites you to make a compression. If problems are with TIDPLAN.MDB use the separate button for 
compression of this database. Tidplan.mdb is used to save the resources profiles.  

 
 

TIP! If you make a compression regularly you can increase the total size of the database and get a faster 
system. 
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Backup database 
To create a copy of the current database click Backup (see picture below), the file is saved in the same 
catalogue as the database files with the extension BAK.  
 

TIP! You should make a backup regularly for preventive purposes in case of a disc crash, virus etc. Storage 
of the backup should be on another server, or another media. 

 

Delete older tasks 
To limit the size of the database there is functions which delete tasks that are older than a specified year 
or limit. Deleted tasks can’t be recovered.  
 
Choose between 3 months, 6 months, 9 months, last year, and several years back 

 
Choose a limit and click Delete. Tasks that have end date newer than the previous year can’t be deleted. 
This is to avoid that you delete all tasks by mistake. After this action you need to make a compression of 
the database.  
 

  
Fig. All tasks with end date before 2012 will be deleted 
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SETTINGS 
 
 
 
 

Settings for program are divided into two forms, Options and Maintenance.  
 

- Options  personal settings 
- Maintenance  for all users (requires login) 

Settings - Options 
On the menu Tools – Options you can make program settings which are individual for each user. The 
settings are saved automatically when you press OK. The button Apply updates the screen with the new 
settings without closing the form. 
 
Tab - View 
 

 
Fig. Program settings under options 

 
Show tooltips Show/hide the help text that is available for the buttons in the 

toolbar. 
 
Show headlines for meetings/to do Show titles for meetings and to do for the Gantt Chart. 

Uncheck and meetings and to do will be showed together.  
 
Show headlines for project Show the title Project in the Gantt Chart. 
 
Headlines appointment/event/tasks Use these title instead. 
 
Show today line Mark today with a red line. 
 
Show gridlines Draw horizontal lines which separate each line in the right 

part of the Gantt Chart. 
 
  



 Settings 

 
 

 110 

Show line number  Show line number in gantt view. 
 
Show Task name in uppercase  Show Task name in CAPITALS. 
 
Go to the first task in table  Choose this to go to the first task in each table instead of the 

chosen date. 
 
Workload by resource  Show the workload for resources. 
 
Show percent completed in chart  Show percentage done as a black line inside the chart. Is 

showed when you have entered worked time. 
 
Show resource name in chart  Show resource name after the bar for tasks from linked tables 

and for filtered lists.  
 
Show task name in chart  Show the task name after bar in chart. 
 
Show category color on tasks  Color of the category is showed for tasks in projects as well. 
in projects.  If you remove the marking all tasks of a common project will 

be showed with the color you have chosen for the project.  
 
Show summary bar for project  Show the summary bar for each project. 
 
Show an overview of projects  Show first a list of all projects and then each project is showed 

with its sub-tasks.  
 

 
Tab – General 
 

 
 
Startup view Choose start view to show.  
 
Language Choose language, Swedish or English.  
 
Columns displayed Choose which columns you want to show in Gantt Chart.  
 
Auto refresh Set automatic update of current view, range 30-300 sec (0.5 - 

5 minutes). The setting is per user. 
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Tab – Printing 
 

 
 
Print gridlines  Print horizontal gridlines in the Gantt Chart for each line. 
 
Print line numbers Print line number in the first column ID, simplifies the 

readability.  
 
Print of weekly planning Choose if project name + task or task only should be printed.  

Choose if the note field should be printed with the task.  
Choose if working order should be printed with the task.  
Choose between printing 5 or 7 days week. 

 
 
Tab – Colors 
 

 
 
Groups   Color of group name. 
 
Users   Color of resource name. 
 
Headlines Color of headlines, todo/project/task list. 
 
Project Color of project name. 
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Task Color of task. If category have been chosen the category 

color is showed instead. 
 
Planned Color of task when actual date or check planned has been 

specified. 
 
Time scale  Color of time scale. 
 
Color Highlighter  Color of highlight row in Gantt Chart. 
 
Color holidays Shades of gray on holidays, both on screen and prints. 

Choose an appropriate grayscale for the printer you are 
using. There are other colors than gray to choose from. 

 
Patterns of the print Pattern of a report from searching database. Odd lines with 

chosen color, so called pajamas paper. 
 
Reset color to default Reset colors to default. 
 
If you use only 256 colors the Reset to default will give other colors than if 16bit or 32bit are uses. The 
colors that can be used with 256 colors to mark holidays start with the text 256, for example. 256 – moss 
green. 
 
 
Tab – Calendar 
 

 
 

View action list  Show task marked as action list in the calendar. 
 
View time  Show start and end time on bars. 
 
Information in bar Choose what shall be displayed on row 2 and 3 in the bars. 

To chow the text you need to increase the row height, 34 for 
2 rows and 48 for 3 rows. 

 
Print date Prints dates in columns along with weekday. For schools, 

uncheck this option to only print day of the week and period 
VT/HT. 
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Time scale Set step size that the bars increases/decreases when you 
change a time with drag and drop. Choose a step length from 
5 – 30 minutes. 

 
 

Tab – Outlook 
 

 
 
You can sync Easy Planning with Outlook so that all changes that are made in any of the systems are 
synced with the other system. 

 
To automatic synchronize with Outlook 

1. On menu Tools, click Options. 
2. Click on Outlook tab. 
3. Check Synchronize every. 
4. Select an interval for syncing, from 15 minutes to 10 hours. 
5. The sync will start automatic with the chosen interval as long as the program is running. 

  
When automatic sync is activated an icon is showed on the status line.  
 

  
 
Log to file 
Check Log to file for analyze. All changes are logged to a text file then synchronizing. File name 
LogSynk_User.txt. 
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Settings - Maintenance 
All settings made in Tools – Maintenance are for all users.  
  

NOTE! Default password is 1234 to login to Maintenance. 
 

 
Tab – View 
 

 
 
Show unacknowledged task Shows unfinished tasks on group and resource level. 

Unfinished tasks earlier than the shown period is marked with 
the symbol << in the Gantt Chart.  

 
Show man-hours Shows the tie in man-hours in linked tables and filtered lists. 
 
Enable to copy/delete/move project Give all users permission to copy, delete and move projects. 

Observe that the choice ‘Show summary bar for project’ must 
be checked in Tools – Options. 

 
No login to Schedule Builder No logon needed to the Schedule Builder. 
 
Enable double-booked warning Get a warning of double-bookings when you save tasks that 

are overlapping times on resources. 
 
If you enable auto refresh, the current view will be updated cyclically in real time, with an interval of 
30-600 sec (10 min). Settings are for all users.  

 

If you want to choose to automatic update only on a special computer you do this in the menu Tools –
Options, tab General. If auto refresh are enabled on both maintenance menu (general) and options 
(per user) the time under options will be used for this user. 
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Tab – General 
 

 
 
Startup view (all users) You can have a common start view for you schedule. If you 

enter a common start view it will override your personal 
choice of start view which you set in the Options menu. 

 
Enter working time There are 3 different ways to enter time worked. 
 
Currency Symbol, position and number of decimal places can be 

specified for currency. Used for showing costs. 
 
Update resource list Used to update the resource list manually. When you assign 

resources to your tasks this list will be updated automatically.  
 

Mark All day event Mark this choice if you want the box ’All day’ marked for new 
tasks. 

 
Preview Printer Choose a PDF writer for preview. 
 
Create order number automatically Mark if order numbers should be created automatically for a 

new task. The order number can be up to 20 characters. 
 
Prefix from schedule file Mark this option if you have multiple schedules sharing the 

same series. Prefix becomes the first letter of the schedule. 
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Tab – Permission 
 

 
 

Under this tab you set permission level for each user. In the full version, all new users get the 
permission selected under ‘default for new users’, in demo version all users get permission 4.  
 
Delete users 
To delete a user, select the user in the list on the left and click on key 'Delete'. Before the user is 
removed from the list, you must confirm this. Do you have a license for 3 users, and you have 4 users in 
the list, you can delete a user if he is no longer using the program. 
  
Tables with all permission 
You can create a list of tables that you give full permission for, although users only have permission 2 
or 3. Useful if your users have permission lower than 4, but should be able to make appointments in 
some tables. Not valid for users with permission 1. 
 
Permission by table 
You can specify which resources should have the permission by table. Used when you book tasks in a 
linked table and select ‘Only by permission’ under the Resources tab. Choose Show All, you can still 
choose from all resources. 
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Tab – Footer 
 

  
 
You can customize the footer with three columns of text. Each column can have any font size and font 
name.  
 

 
 

Key words are replaced by the following text:  
 
&[Rubrik] Heading on the schedule from the schedule builder, field "Department/title' 
&[Vecka] Weekly planning (1 week), 3-week plan (3 week) etc. 
&[Grupp] Replaced with group name. 
&[Tabell] Replaced with table name, not printed at group level. 
&[Projekt] Name of project, printed only when a filtered lists or a project is selected. 
 
Custom logo on printouts 
You can add your own logo by clicking on key Add. Maximum size of a logo is 195 x 65 pixels and 
the file type should be BMP/JPG/GIF. Logo is per database. 
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Tab – Categories 
 

 
 
With filtered lists you can sort out and show all tasks of a certain type. To use filtered lists you need to 
create a category list first. Then added tasks, select a category from the category list. Each category can 
be assigned with a color and hourly rate. 
 
 
Hide tasks for Viewers 
You can hide tasks by selecting ‘Hide for Viewers’ for one or more categories. Users with level 1 can’t 
see these tasks. 
 

 
 

 
Tab – Project 
 
Add project manager and type of project. 
 
Tab – Database 
 
Functions for database maintenance described in chapter Database.  
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Tab – Tables 
 

 
 
Tab tables show all tables that have been created in the database (except for system tables). Each box 
in the schedule creates a table in the database. The list contains table name, created date and time and 
number of records. 
 
 

Note! For boxes in the schedule that you have marked with a category (filtered lists) there are no tables. 

 
Delete table 
Delete marked table. All tasks will be deleted. You need to confirm before the table is deleted.  
 
Rename table 
Rename a table name. If you change a name in the schedule that contains tasks the table name will 
automatically be renamed. 
 
Linked tables 
In a linked table you can select resources. The table is different from the others since if you copy a task 
from a linked table and paste it on a regular table you will create a link (a resource).  
 
Mark a table name in the left list and press right arrow. The table name shall now be showed in the right 
table under linked tables. You can also use drag-and-drop to select tables. 
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Tab – Message 
 

 
 
Outlook synchronize 
To sync with Outlook, select the 'Sync calendar' and/or 'Sync task'. Want all tasks combined in the 
Outlook calendar, just select Sync calendar. If you select Sync task will all day events be synchronized 
with tasks in Outlook (a separate list in Outlook). Check Exchange if you are using an Exchange server.  
 
Select a resource (table) in the lower list and click Change. Enter Column Exchange, login and sync 
with Sync Master if this program will be used. You can also double-click in the column Sync to quickly 
toggle sync Yes/No. 
 
 
Send message 
The function send message is used to send a message if one user change in another users planning 
(except for SMS). Have you enabled the feature, that person will receive an email about who and what 
has changed. 
 
You can choose between using RealPopup, Outlook or SMS to send message. Real Popup is a 
freeware program that can be downloaded from www.realpopup.it. Real Popup only send message 
over the local network, which increases data security compared with sending email over the Internet. 
When ’Send message’ is enabled, an icon appears in the status bar. 

 
 
Before you start using the function Send message you have to choose if you want to use Outlook or 
RealPopup to send messages. If you are going to use Outlook enter an E-mail address for each users 
table. 
 
If you are using the program RealPopup you must enter a computer name for each user for the 
network. RealPopup have to be running to be able to send messages. Note that the program 
RealPopup must be installed in the catalogue c:\program\realpopup to be able to use. 
 
To enable the function send message you mark the box ”Send message”. You can disable the function 
by unmark the box.  
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Tab – Calendar 
 

 
 
Working hours 
Enter the start and end of the work day. Used for calendar and resource view. Hours per day can be 
entered, default 8 hours.  
 
Breaks 
You can enter up to 3 brakes. These are marked with a gray background in the calendar and resource 
view. 
 
Copy week 
This function is only for schools. It works by allowing you first add all substance for a class in a linked 
table for one week. You can then copy this week a number of weeks ahead but except for holidays 
etc. 
 
Note! You can only copy from a linked table (consists of a class for a school). 
 
 
Scheduling for schools 
To create a school schedule you create an schedule in Schedule Building consist of a group of classes, 
create them as linked tables. Then a group of halls and a group of teachers (these are resources).  
 
Then you can book subjects for a class, choose an available hall and a teacher. When the schedule is 
booked (only booking first week of the school term) you just copy this week to all other weeks this 
school term except for school brakes. Then you schedule the next class and so on.  
 
From the schedule you can click on a class, a hall or a teacher and see the bookings for any given 
week, use the calender view for this. 
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FILES AND SHORTCUTS 
 
 
 

 
File structure 
 

The following files are installed in the same direc tory as the program 
 
WINEP6.EXE Program 
WINEP6.CHM Help file 
WINEP6.EXE.MANIFEST For WinXP layout 
WINEP6.DAT Licence file 
PROJEKT.CFG Schedule file (demo) 
PROJEKT.MDB database in mapp databas (demo) 
 
 
 
Sub directories  
 
c:\Program Files\Easy Planning 

\Databas 
\Status 
\Tid 
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Keyboard shortcuts 
Help F1 
Schedule F2 
Planning F3 
Timesheet F4 
 
Go To F5 
Database F6 
Edit task F7 
 
Gantt Chart 3 weeks F8 
Resource view 5 days F9 
Calendar Shift+F9 
Zoom in F11 
Zoom out F12 
 
New Task Insert 
Delete tasks Delete 
Complete tasks End 
 
Undo CTRL + Z  
Redo CTRL + Y 
Cut CTRL + X 
Copy CTRL + C 
Paste CTRL + V 
 
Find CTRL + B 
New CTRL + N 
Open CTRL + O 
Save CTRL + S 
Print CTRL + P 
 
Scroll a page in planning Space 
Forward one week Right arrow 
Backward one week Left arrow 
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